Adobe™ InDesigh® 2021

Text, Styles, and Page Numbers

une Woorne, Dorothy Rucsly, and Rebetat (Prodson

March 2022



InDesign: Text, Styles, and Page Numbering

Introaduction...

This tutorial is a step-by-step guide to a few basic tasks in Adobe™ InDesign®
2021. The audience is novice users who are technical and professional writing
students at UNC Charlotte.

The tutorial provides instructions on how to:

1) set up, name, and save an InDesign document;

2) create text boxes and fill them with placeholder text;

3) create a heading style in a specific typographic style;

4) apply the new heading style to headings in the document;

5) create a paragraph style;

6) apply the paragraph style to the text in a text box; and

7) use the parent page function to apply page numbers and a running header.

The tutorial is simplified and customized to get students in UNC Charlotte
courses quickly into using InDesign for their coursework. The students in these
courses may have a wide range of experience with Adobe InDesign from no
previous experience to advanced professional experience. These students are
preparing for professional positions as technical writers, graphic designers,
usability experts, and other related careers.

The tutorial is intended to be open next to a blank InDesign document and
followed step-by-step as the student works through the tasks. By the end of the
tutorial, students will be able to repeat the tasks independently and build their
expertise with other tutorials that focus on other basic InDesign tasks.
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Create an InDesign Dacument...

@ Download and install Adobe InDesign on your computer.
@ Double-click the . desktop icon on your computer desktop or select

o
Creative Cloud t(? from your list of applications on your Windows [ menu
and open the latest version of InDesign from the list. Wait while the applica-
tion loads.

<?> Double-click on “Letter N

Welcome to InDesign, Anne

O ] =3 e

iPad Pro Web 1920 More Presets

@ A blank letter-sized document
will open.
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e Ed Layout ype Object  Table View  Win

<5> Click on the File menu and select “Save e ,
As.” Open... Ctrl+O

Browse in Bridge... Ctrl+Alt+0

Open Recent >

Close Ctrl+W

Save Ctrl+5

Save As... Ctrl+5hift+5

Check In...

Save a Copy... Ctrl+Alt+5

Revert

Search Adobe Stock...

Place... Ctrl+D

Place from CC Libraries...

Impart XML...

Import PDF Comments...

Adobe PDF Presets »

Export... Ctrl+E

Share for Review...

Publish Online...
Publish Online Dashboard...

Document Presets »
Document Setup... Ctrl+Alt+P

Click on the folder where you wish to save your document. (“Desktop”).

@ save As

« v 4 B > Anne Moore » Desktop A o A Search Desktop

Organize - New folder

@ CneDrive - Pers ” Name Date modified Type Size

2 Anne Moore No items match your search
.cisco
B 3D Objects
w Contacts
w Creative Clou
B Desktop
< Documents
# Downloads
& Dropbox (Pers:
% Dropbox (UNC
e ENGL5181 S
@ Diagostic W
e ProjectOne v
File name; My InDesign Document 1
: InDesign 2021 document
Always Save Preview

Images with
Documents

o] o

» Hide Folders

@ Type a Name for the file in the “File name:” field. Click the “Save” button.
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Jeatboa with Fillern I
Create a I ¥ Jeat...

@ Click on the white T on the vertical Toolbar.

EIDYYV

@ Click in the document, hold
down the mouse button while
you drag down and to the right
in the blank document to create
a Textbox of any size.

T,
/

2,
s,
B,
Cl,

textbox

@ Right click inside the Textbox to bring up the fly out menu.
Left click on “Fill with Placeholder Text.”

The Textbox will be fillegfwith Lorem Ipsum filler text.

Paste Ctri+V

Font »

Size »

Find/Change... Ctrl+F

Spelling » Amusa eum que ea volo odipisc itesto

Text Frame Options Ctrl+B bearum ab intianda quis idiossi taturi

. cuptatem id elesti de por molut occus aciet

k]

ANEHoRSE Onjact laborer iostore nusci aut istori tet harum

Change Case » aut estrume nihicillis ent, officae etum dit

Show Hidden Chargcters Ctrl+Alt+| et erro molorer ibusam ea verions equunt,

soluptas ipsam dit volecatiis etur, voluptaest

quidis eiume nonsectur re, voluptiis expe

molupta tionectemqui officias min perupta
» tibusam is as aut enditium hil iunt lam as
dem con con planit dem dollaut aliquibus
et, odi adignatem solor auditias et faciaep

Insert Footnote
Insert Endnote

Insert Variable

1 -] . . .
Insert White e erchitemqui desed ea quiam, cuptatur?
Insert Break Lharacter ’ Henimporum fugiasp elleseq uiatius.
Fill with Placeholder Text Aborepuda imporporepta vellora -:ritatiu|
Tac Text ¥
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Creating a New HeadingStyle...

1. Create a new blank text box at the | e
top of the page (following steps 1 and 2 Ag Dore]
under “Create a Textbox above”). In the A.
new text box, type in the word “Heading” —
and center it, using the center button TR
found in Properties menu under i s
“Paragraph.”

2. Make sure you have the Character Styles
panel selected in the Properties panel.
It is located next to the Paragraph Styles
panel.

Bullets and Mumbering

] | Quick Actions

You will now change the font size
of the “Heading” text.

1. Highlight “Heading.” Next, look at
the Character section in the Properties
panel. The Character section is the
second section, underneath the

Appearance section. ~
pp 1 © 12pt v

2. You will see an icon that looks like a
little T and a big T. This is the icon for
font size. Use the drop-down arrow to
change the font size to 36pt.
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Next, you will change the font
style

1. While the text is highlighted, you
will click the drop-down arrow of
the first Character search bar.This
is the font search bar. The current
font style is Minion Pro.

2. After clicking the drop-down
arrow, you will use the scroll bar
to find the font Bell MT. Once
you have found this font, Select it.

InDesign: Text, Styles, and Page Numbering

Magnatg

Maiandra GD

Marlett

Matura MT Script Capitals
Mesapite Std

Micrazaft Himalaya
Micrasaft Mew Tai Lue (2}
Micrgsalt PhagsPa (Z)
Micrgsalt Sars Sert
Micrasaft Tai Le (2)
Micrasaft i Bai

Miricn Pro {100

Test Syl
Parapraph ez
Ag [Hona]

||-J'

AP araiE

E Al
|

Chi ractar

.- TR
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Now that you have changed the font style, you will now change the
font to bold/italics

1. Underneath the first search bar,

you will see another search bar that
shows Regular.

Properties
Characters
Text Style
Paragraph Styles
2. Click the down arrow for the bold
and italics selections and choose the

desired one. In the example below,

Bold was selected for the Bell MT
font.

Ag [None]

A.

Appearance
' Fill
n Stroke

Character
Q~ Bell MT
Regular

vy

Italic

» Bold

11 | |1U0%

Headin g‘

This is the text now in a new font style and in bold.
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The final step of this task will be to change the color. Remember to
keep the text highlighted.

1. Look at the Appearance section
above the Character Section. This
is where you can change the font
color.

2. You will notice two white squares g
that have a red line running n Fill
diagonally through each one. One P

‘ Stroke

will be titled Fill and one will be
titled Stroke. In order to add
color to the text, you will use the
Fill option. Click the square next
to Fill.

3. You will now see a smaller R
window that shows a variety of /I
colors to choose from for your text. 4= » o (RS
For this practice, select the red that T :
has the C=15 M=100 Y=100... I i

Tink:

properties. This will change the e

Fi [Nona]

color of your text. ety X W ] LSl

. aracter

W [paper]
[Black]
C=100 M=0 ¥=D K=0

C=0M=100 ¥=0 k=0

B c-0M-0¥-100 k=0

C=75 M=5 ¥=100 K=0 B H

E -

Good work! You have now successfully changed the font size, style,
bold/italics, and color. Now that the changes have been made, you
can name your new typographic style.
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Naming New Jypagraphic Style...

Make sure that your “Heading” text is highlighted. You will also want
to double check that you are still in the Character Styles tab in the
Properties menu on the right. This is particularly important in naming
your new style.

1. In the Character Styles panel, you will see an A. icon like this. Click the A.
icon. Once you click the icon, a list of options will appear. Click the first option
that says Character Styles.

2. A new, smaller window will appear. Look down at the bottom panel of this new

window. You will see a small icon that is a square with a plus sign. m This is
the Create New Styles icon. Click it.

Pasraecdii condi: prooneguedii puli frobss: fnvem, me etne, enudesnin W g macien, caed e, publii
Wl Poriiie o dmodin, gues Ad delian

Mis versdien sede, g tedd B b iis pertend, naim dloan iy eriasad b L s o b mis

e Riiials essilberii b Sevieat drobs, Carn qais fic o etinedes publi eroporsnnmm disad 16,
plibliquann dinbescit ion. Bor e, vil femis Wvemnil saipes o, qiid consimmie dffresid e oars alicee con-
niiid Diiir pl. Dopad 4 cuirmiinais, comsile]ie oo bare? Vile diiide mecTinm Jen i, e warkd el
Fierael bevitd < beindel ssene, ok popesd i dismiations. el firk, TG
rreeriers cpubidkeurding pa R sere 0 Do i quan ik moles borsalis
e TS T AT e TER Ty L A TR T AP EE TR T Charaebers Tiyles
peaee besnwm Bihine fans sim egerobil vicstien B Habem dguam ad
widhet wivid poan s T R e B ducarraLn (e nnade TiRamn ot pe dd gy
o wrokianin o dam pubbn peoaien pablia den csnns ool vidiors sed
PR T T OF AN e b Paben ol et ivey LT LAIT GpAEnD . Sl
Ok b @i et D@Lind im0l i PelpLa s GRird SLOBIARE T ¥
i T s vis b BB, testrae. e i i nestn e pehiekanas s
i dhiim ef poatreirbern die ipes il bl g

Lincubinaris A anom. sil | condi chemiit. Habis soeris ine 5t v
it by £ ket v con e nee i o 18 vinmdine adaim e O
staqildem pericis? Moram btk g monsl APk i DD Se e

sl fncluite paabdibiane cee -cﬂ'r\-:hc-lml-r--:iru.--.u anld i T @ e
IETI Pl o, iess s wadim intern iddenenil. Has menim p
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3. A new name will show up in the list, Character Style 1. Double-click this
title and a new window will open.

4. In the new window, you will see a bar at the top titled Style Name. Replace
“Character Style 1” with a new name for your font type.

I-Eharal:izr Style Opticre

WARNING: Before you rename, check that the properties you
applied to the new font type have remained the same. Otherwise, all
of your hard work wont be saved!

5. In order to check this, you will look at the left panel and find the
names Basic Character Formats and Character Color. You will click

each option on the menu, starting with “Basic Character Formats.”

6. When you click each option, you will see the unique features of
your font type: size, font style, and bold/italics.
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7. If everything is correct, click okay. Then, rename your new font type in the
Style Name bar. In this example, the new style is named with the default
Character Styles 1.

8. Once you rename your new typographic style, click OK to save and then
close the Character Styles window. Notice that your new font type is visible
in the Properties panel under the Character Styles panel.
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Congratulations! You have now learned how to make a new
typographic style and name it! Now you can move on to the next
step!
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Creating a Saragraph Style

1. Select and highlight the text. Open the Paragraph Styles panel on the right
side and choose New Paragraph Style.

[ZEETIRY S

L IR LR ]
I'epnin

[egd o |

Ted ki

AEFENEEE

TH

- QT

' lvpe hene Bz osmarch

2. The New Paragraph Style dialog box will appear with a generic name
highlighted. Give your new style a new name and press enter or click ok.
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Upplying a Jaragraph Style

1. Apply the style to any paragraph by positioning your text cursor within it or
highlighting the text, and then clicking on the name of the style you saved in the
Paragraph Styles panel.

“liniHied-T & 142% *
Fripaiee L H 1.1 A,

= - 1| of Lbrari..
Snmn sita dolorem poreheniet guue

de imin cupta possit, sim is debis « A crarsder
¥oIm gque nonsend itiorer iberovi ta

alit la se corvest haritia iny, andips: Lars barsgenzh]
NMende il idio. Nam que plabo. Ut a
ut alicimus diti rem fugit id enihil,
poreper natuy, invelig nihitibuc ec
Dit, seribus aces pellabo restiis du g aph ke
cusanim harcimi nizitas perupta 1
¥it adi con premporre quate gui is
lupta quam, quac conscquibus ut
sinte diorepre deolum quasim doxn PRGNS
voluptatins ullis venimil ibusamet
riate voloreperae. Ut apit odionseq
rninvendis recullore nullab ipsam,
dant verum etury modi re velitarm oy GREE
conscedls inmguostrum nemolesequain
nis 5iti simpos eati debit gquat ut ut eague
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‘&eate a Sarent Sage...

A Parent (or Master) Page is a nonprinting page that serves as
a template that can be applied to some or all of the pages in your
document. Parent pages contain text and graphic elements like page
numbers, headers, footers, etc. that you want on all or most pages.
You can have as many parent pages as you want in a document and
apply them to individual or groups of pages.

<1> On the upper right side of
the InDesign document

Essantials «

screen, click on the Pages panel. If 8 S :

. . “&  Properties
the Page§ panel is not showing, go [ s
to the Window drop-down menu dli Pages
and click on Pages to reveal it. AN [¥ CC Libraries

: Double-click on A-Parent in the
Pages panel to display the Parent
Page.

Udd Uutematic Page Numbens...

<]> With the A-Parent still highlighted, create a textbox large enough to hold
the longest page number and any text you want to appear with it. Position
the textbox where you want the page number to appear, normally in the

lower right margin of the document. \
|

@ In the page number textbox, add any text that will come before or after the
page number (such as “Page ”) and format it using the Paragraph Style you
set up previously.

Position the insertion point where you want the page number to appear,
and from the Type drop-down menu select Insert Special Character >
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Font
Size
Character

Paragraph

Tabs

Glyphs

Story

Character Styles

Paragraph Styles

Create Outlines

Find/Replace Font...

Change Case

Type on a Path

MNotes

Track Changes

Insert Footnote

Document Footnote Options...
Insert Endnote

Document Endnote Options...
Convert Footnotes and Endnotes...
Hyperlinks & Cross-References
Text Variables

Bulleted & Numbered Lists

Insert Special Character

Insert White Space

Insert Break Character

Fill with Placeholder Text

Show Hidden Characters
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Ctr+T
Ctrl+Alt+T InDesign Tips and Tricks
Ctrl+Shift+T
Alt+Shift+F11
Shift+F11
F11
Ctrl+Shift+0
"4
>
v
>
¥
>
& Symbols >
X Markers > Current Page Number Ctrl+Alt+Shift+N
# Hyphens and Dashes > Next Page Number
Quotation Marks > Previous Page Number
Ctrl+Alt+| Other > Section Marker

Footnote Number

Character

Language:  English: USA

Page 1
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Udd a Running FHead...

@ With the A-Parent still highlighted, create a textbox large enough to hold
all the text of the running head in the location you want it, usually above the
frame of the document in the margin and aligned right.

C Type the text you want to appear at the top of every page. Format it using
the Paragraph Style you set up previously.

Upply the Farent te your Sages...

<1> Right-click on a page to which
you want to apply the Parent
Page in the Pages panel on the __
right. "o Properties
[Mone]
ik Pages
A-Farent e
@ (" cc Libraries
Select Apply Parent to Pages. '
You can apply the Parent Page
to any or all pages.

Essantials

Insert Pages...
Move Pages...
Duplicate Spread

Print Spread...

Apply Parent to Pages...

Override All Parent Page Items Ctrl+Alt+Shift+L

Create Alternate Layout..
Mumbering & Section Options...

<

Allow Document Pages to Shuffle
~ Allow Selected Spread to Shuffle

Page Attributes >

View Pages >
Fanel Options...

Congratulations! You have now learned how to add page numbers,
a running head, and a parent to your InDesign document! You have
successfully completed this tutorial!
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